
Use business software applications 
This workbook supports BSBTEC201 Use business software applications in the Business Services Training 
Package. 
 

Author 
Software Publications writing team 
 

ISBN 978-1-921971-70-9 
 

Copyright and restrictions 
© Millbank Investments Ltd, 2021 
 
Under the Copyright Act 1968, training organisations are permitted to reproduce a total of 10 per cent or 1 chapter 
(whichever is greater) of this book for educational purposes providing the Copyright Agency Limited 
info@copyright.com.au is notified of the copying including number of pages, ISBN, author and publisher of the 
material. Original copyright statements must appear on reproduced material. 
 
Except under the conditions stated, no part of this publication may be reproduced or transmitted in any form or by 
any means, electronic or mechanical, including photocopying, scanning, recording or any information storage and 
retrieval system without permission in writing from the copyright owner or Software Publications Pty Ltd. 
 

Electronic distribution and hosting 
No part of this publication may be distributed by electronic or mechanical means. No part of this publication may 
be hosted, held, shared or published on a third party website, intranet or learning management system without 
permission in writing from the copyright owner and Software Publications Pty Ltd. Permission may be sought in 
writing from office@softwarepublications.com.au. 
 

Software Publications Pty Ltd  
ABN 75 078 026 150 
Head Office - Sydney 
Unit 3 
25 Gibbes Street 
Chatswood NSW 2067 
www.softwarepublications.com.au 
 

Published and printed in Australia 

 

  



Contents 
BSBTEC201 Use business software applications ................................................................ 1 
Assessment for this unit ........................................................................................................ 2 
How to use this workbooks ................................................................................................... 3 
How to download exercise files ............................................................................................ 5 

SECTION 1: USING TECHNOLOGY ....................................................................................... 7 
Work Health and Safety Act 2011 ......................................................................................... 8 
Work safety ........................................................................................................................... 9 
Ergonomics ......................................................................................................................... 11 
Occupational overuse syndrome ........................................................................................ 14 
Computer vision syndrome ................................................................................................. 15 
Physical exercises to avoid strain ....................................................................................... 15 
Breathing ............................................................................................................................ 17 
Selecting equipment ........................................................................................................... 18 
Equipment faults ................................................................................................................. 20 
Data .................................................................................................................................... 22 
Copyright ............................................................................................................................ 22 
Data loss threats ................................................................................................................. 23 
Unauthorised access threats .............................................................................................. 24 
Malware threats .................................................................................................................. 24 
Organisational policies to protect digital data ..................................................................... 26 

SECTION 2: DOCUMENTS AND FILES ............................................................................... 27 
Document requirements ..................................................................................................... 28 
Style guides ........................................................................................................................ 29 
Conventions for personal names ........................................................................................ 30 
Planning a document .......................................................................................................... 30 
File management ................................................................................................................ 31 
Types of files ....................................................................................................................... 34 
File naming procedures ...................................................................................................... 36 
Selecting applications ......................................................................................................... 37 

SECTION 3: WORD PROCESSING ...................................................................................... 38 
Word processing applications ............................................................................................. 39 
Notepad and WordPad ....................................................................................................... 39 
Microsoft Word .................................................................................................................... 41 
Saving a document ............................................................................................................. 46 
Creating a document .......................................................................................................... 47 
Spelling and grammar ......................................................................................................... 47 
Opening files ....................................................................................................................... 48 
Navigating through a document .......................................................................................... 50 
Selecting text ...................................................................................................................... 50 
Undo and Redo ................................................................................................................... 52 
Line and paragraph spacing ............................................................................................... 52 
Help .................................................................................................................................... 54 
Moving and copying ............................................................................................................ 55 
Fonts and formatting ........................................................................................................... 57 
Horizontal alignment ........................................................................................................... 59 
Inserting pictures ................................................................................................................ 60 
Templates ........................................................................................................................... 63 

  



SECTION 4: SPREADSHEETS ............................................................................................ 65 
Spreadsheet applications ................................................................................................... 66 
Microsoft Excel ................................................................................................................... 66 
Opening a workbook .......................................................................................................... 68 
Rows, columns and cells .................................................................................................... 69 
Selecting cells .................................................................................................................... 70 
Formulas ............................................................................................................................ 71 
Help .................................................................................................................................... 71 
AutoSum ............................................................................................................................ 72 
Mathematical operator symbols ......................................................................................... 74 
Workbooks ......................................................................................................................... 75 
Creating a workbook .......................................................................................................... 76 
Entering cell contents ......................................................................................................... 76 
Editing cells ........................................................................................................................ 77 
Deleting .............................................................................................................................. 78 
Undo................................................................................................................................... 78 
Widening columns .............................................................................................................. 79 
Copying formulas ............................................................................................................... 83 
Formatting a worksheet ...................................................................................................... 84 
Borders............................................................................................................................... 85 
Alignment ........................................................................................................................... 90 
Merging cells ...................................................................................................................... 90 
Formatting numbers ........................................................................................................... 92 
Formatting dates ................................................................................................................ 93 
Charts................................................................................................................................. 96 

SECTION 5: PRESENTATIONS ........................................................................................... 99 
Presentations ................................................................................................................... 100 
Microsoft PowerPoint ....................................................................................................... 100 
Creating a slide ................................................................................................................ 103 
Help .................................................................................................................................. 104 
Creating a presentation .................................................................................................... 105 
Applying themes ............................................................................................................... 107 

SECTION 6: DATABASES ................................................................................................. 109 
Database management systems ...................................................................................... 110 
Microsoft Access .............................................................................................................. 110 
Opening a database ......................................................................................................... 110 
Help .................................................................................................................................. 112 
Viewing a table ................................................................................................................. 112 
Viewing a form ................................................................................................................. 113 
Entering, editing and deleting a record ............................................................................ 114 

  



SECTION 7: EMAILS ........................................................................................................... 115 
Email accounts ................................................................................................................. 116 
Email policies and procedures .......................................................................................... 117 
Microsoft Outlook .............................................................................................................. 117 
Adding the first account to Outlook ................................................................................... 118 
HTML format ..................................................................................................................... 119 
Adjusting the Outlook display ........................................................................................... 120 
Creating an email .............................................................................................................. 123 
Setting a priority ................................................................................................................ 124 
Checking spelling .............................................................................................................. 124 
Receiving emails ............................................................................................................... 126 
Replying to and forwarding emails .................................................................................... 126 
Signatures ......................................................................................................................... 128 
Disclaimer statements ...................................................................................................... 129 
Sending an email to several people .................................................................................. 130 
Saving an email to send later ........................................................................................... 132 
Selecting emails ................................................................................................................ 132 
Deleting emails ................................................................................................................. 133 
Sending documents by email ............................................................................................ 133 
Saving attachments .......................................................................................................... 134 
Flagging emails ................................................................................................................. 135 
Managing emails ............................................................................................................... 135 
Junk email ......................................................................................................................... 138 
Contacts ............................................................................................................................ 140 
Groups .............................................................................................................................. 141 
Help .................................................................................................................................. 143 

SECTION 8: PORTABLE DOCUMENT FORMAT (PDF) .................................................... 144 
PDF readers ..................................................................................................................... 145 
Creating a PDF from Word ............................................................................................... 145 
Creating a PDF from Excel ............................................................................................... 145 
Publishing a presentation as a PDF ................................................................................. 146 
Adobe Acrobat Reader ..................................................................................................... 147 
Adobe Help ....................................................................................................................... 148 
Viewing and commenting on a PDF ................................................................................. 148 
Signing a PDF ................................................................................................................... 149 
Secured PDFs .................................................................................................................. 150 

ASSESSMENT ..................................................................................................................... 151 
Assessment tasks ............................................................................................................. 152 
Evidence guide ................................................................................................................. 157 

INDEX ................................................................................................................................... 159 
 



© Millbank Investments Ltd, 2021 1 

BSBTEC201 Use business software applications 

Application 
This unit describes the skills and knowledge required to select and use software and 
organise electronic information and data. 

This unit applies to those who use a limited range of practical skills with a fundamental 
knowledge of equipment use and the organisation of data in a defined context, under direct 
supervision or with limited individual responsibility. 

No licensing, legislative, regulatory or certification requirements apply to this unit at the time 
of publication. 

Elements and Performance Criteria 
Element 
Elements 
describe the 
essential 
outcomes. 

Performance Criteria 
Performance criteria describe the performance 
needed to demonstrate achievement of the element. 

Page reference 

1. Select and 
prepare to use 
technology 

1.1 Identify task purpose, audience, format and 
presentation requirements, and clarify with relevant 
personnel where required

28–30 

1.2 Select relevant technology and software 
applications to achieve requirements of the task

18–19, 37 

1.3 Adjust workspace, furniture and equipment to suit 
own ergonomic requirements

11–13 

2. Input and 
process 
information or 
data 

2.1 Identify and open application, according to task 
and organisational requirements

37, 39, 41, 66, 100, 
110, 117, 147

2.2 Enter information or data into application 
according to organisational requirements

Throughout 
workbook 

2.3 Ensure information or data is checked and 
amended according to organisational and task 
requirements 

47, 82, 114, 124 

2.4 Format information or data using appropriate 
application functions according to organisational and 
task requirements

29, 45, 52, 57–59 
76, 83–91, 107 

2.5 Use relevant help functions to overcome simple 
issues  

54, 71, 104, 112, 
143, 148 

3. Finalise and 
store data 

3.1 Review and edit final information or data, and 
prepare for storage in accordance with organisational 
and task requirements

47, 82, 114, 124 

3.2 Name and store document and exit application  36, 40, 46, 48, 68, 
76, 107, 111, 114, 
125, 149 
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Foundation Skills 
This section describes language, literacy, numeracy and employment skills incorporated in 
the performance criteria that are required for competent performance. 

Skill Description Page reference 

Reading  Recognises and interprets information from familiar 
sources to determine job role and task 
requirements 

5, 9–10, 20–21, 
29, 36 

Writing  Produces and amends files to meet task and 
organisational requirements

39–114, 145–149

 Completes required documentation using 
organisational formats

Throughout 
workbook 

Assessment for this unit 
This unit is assessed by: 

 interpreting information and data 

 selecting appropriate equipment and applications 

 creating documents based on information and data 

 saving and storing documents. 

Assessment Requirements 
The candidate must demonstrate the ability to complete the tasks outlined in the elements, 
performance criteria and foundation skills of this unit, including evidence of the ability to: 

 select and use at least three business software applications on two occasions each. 

Performance Evidence 

In the course of the above, the candidate must: Page reference 

 select and use technology safely and according to organisational 
requirements 

9–17 

 identify and address faults according to requirements. 9, 20–21 

Knowledge Evidence 

The candidate must be able to demonstrate knowledge to complete 
the tasks outlined in the elements, performance criteria and foundation 
skills of this unit, including knowledge of:

Page reference 

 key features of:   

 organisation’s work health and safety requirements relevant to 
own role 

8–10 

 organisation’s requirements for file naming and storage 36, 40 

 applications used for organising electronic information and 
data. 

31–33 
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How to use this workbooks 

Files used in this workbook 
You will require exercise files downloaded following the instructions in this workbook. Check 
that all the files listed have been downloaded. 

 Assessment (folder) 

 Correspondence (folder) 

 Finance (folder) 

 Cafe.jpg 

 Coogee Dive Club.accdb 

 Costello.docx 

 Dining out.docx 

 Fashion House.xlsx 

 Folders.png 

 Good food news.pdf 

 Italy.doc  

 Northland.docx 

 Ocean sales.xlsx 

 Order form.pdf 

 Phone City.xlsx 

 Planning a wedding.docx 

 Quotation.xlsx 

 Randalls Book Stores.pptx 

 Spa therapies.docx 

 Staff expense report.xlsx 

 Tables.docx 

 Tomatoes.png 

 Tracey's budget.xlsx 

 Ultimate outcomes.xlsx 

 Utensils.png 

Spelling and grammar in this workbook 
At times different spellings of one word are used in this workbook. 

References to buttons, groups, tabs and other features are used in the same way as they 
appear in the application so instructions resemble the application as closely as possible. 

In all other instances Australian spelling is followed, e.g. the Font Color button is used to 
change the colour of selected text. 

Shortcut key combinations 
Shortcut key combinations are shown in the left margins of this book, e.g. where using the 
Open button is instructed in the text, the shortcut key combination is included:  

 

To use the shortcut key combination press and hold down the keys in the order given, i.e. 
hold down the Ctrl key then press the O key. 

  

Ctrl O 
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Occupational overuse syndrome  
Occupational overuse syndrome (OOS) is a collective term for a range of conditions which 
cause discomfort or pain and which are caused by performing repetitive tasks. Symptoms 
include: 

 fatigue 

 pain in the muscles or tendons 

 burning sensations 

 stiffness 

 weakness 

 numbness and tingling. 

People who work with digital devices for lengthy periods are particularly susceptible to OOS. 
Typing and using the mouse both require repetitive actions which can result in pain in the 
hands, wrists, arms, shoulders and neck. OOS can also be exacerbated by inappropriate 
office furniture, poor workstation layout and poor work organisation. 

Overuse of a smartphone can result in ‘texter’s thumb’ where the tendons of the thumb 
become swollen and painful. 

Steps to reduce OOS risk 
Create an ergonomically correct 
workstation 

A correct workstation layout can have a big impact on 
OOS prevention. Follow the information on setting up an 
ergonomically correct workstation and using portable 
devices safely covered earlier.

Vary tasks Try to organise your day so that you vary your tasks. 
Typing non-stop for a long time can be damaging. Take a 
break from your computer – make business calls, file 
documents, get a glass of water to drink. 

Take breaks You should take frequent breaks away from your screen 
to avoid eyestrain and posture problems. The 
recommended break is 5–10 minutes every hour worked 
where work is screen-intensive. Make sure you do not 
work through your lunch break.

Limit use Portable devices, by their very nature, can be carried 
everywhere. This can lead to overuse by being tempted to 
check work emails at unsuitable times such as when lying 
in bed, disturbing sleep patterns. Set limitations on use of 
your device and try and stick to them.

Micropause A micropause is a short break from work for muscle 
relaxation. Generally it is a 5–15 second break every 5–
10 minutes. Micropauses allow for the restoration of blood 
flow to muscles which have been held tense. Applications 
are available that remind you to take regular 
micropauses.
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Conventions for personal names 
In most western cultures a person has a first name, followed by a last, family name; however 
in some eastern cultures the order is reversed. When you encounter a name from a culture 
you are not familiar with, you may not be able to determine which is which. Depending on the 
organisation and the age of its data, you are likely to come across different generations of 
personal name terminology. When creating documents current conventions should be 
applied. 

Current convention Previous terms 

Given name First name 
Christian name 
Forename

Family name Last name 
Surname 
Byname

Planning a document 
Documents in the workplace are created to meet a specific need and will have a purpose and 
an intended audience. This should be identified by the person requesting the document. It is 
more efficient to draft the document in the app and ask for feedback. 

Purpose 
The document purpose is the reason for the document; to inform, to provide instructions or to 
persuade the audience. The purpose will determine the content, layout and language used, 
e.g. a document that provides instructions may include a list of short numbered sentences 
and an advertisement will use descriptive words and images. 

Audience 
Knowing who will be reading the document sets the tone which will be suitable for that 
audience. Aspects to consider are: 

Requirements Why will they be reading your document? What information will they 
need? 

Age Slang may be appropriate with a younger audience, but it would not 
be appropriate with an older audience. Simple words and layouts can 
be used for an audience of children.

Knowledge Reports for subject-specific audiences can use technical terms which 
would not be used with the general public.

Example plan 

If you have been tasked with creating a document, a simple plan as below may make things 
clearer.  

Purpose Advertise the library gala

Audience Library patrons – children to senior citizens

Design Visually interesting and engaging 
Must use library style guide

Format One-page A5 flyer

Text Date, time, location 
List of events that will take place

Deadline Next Friday 
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File management 
File Explorer is a file management app included in Windows 10 designed to help you 
manage files, folders and drives. 

Starting File Explorer 
Exercise 2 

1. Click on the File Explorer button  on the taskbar 

OR 

Click on Start  for and click on . 

The Navigation Pane is on the left and the Details Pane on the right. The drives and folders 
showing will depend on how your device had been set up. 

 
 

 

 

2. Leave File Explorer open for the next exercise. 

File Explorer Ribbon 
The File Explorer window has a Ribbon at the top. The main part of the Ribbon may be 
hidden when File Explorer first opens, however this can be pinned so it displays all the time. 

Exercise 3 

1. With the File Explorer window open check whether the Ribbon is displayed. If the full 
Ribbon is displayed, click on the Minimise the Ribbon button  in the top right corner of 
the Ribbon to hide it. 

2. Click on the Expand the Ribbon button  in the top right corner of the Ribbon. This will 
display the Ribbon in its expanded form. 

3. Leave File Explorer open for the next exercise. 

Details Pane Navigation Pane 

Minimise the Ribbon 
button

Address bar
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Quick Access Toolbar 
The Quick Access Toolbar located in the top right corner of the window contains commands 
to Save, Undo and Redo. Frequently used commands can be added to this toolbar. 

 

The AutoSave option is only available if you are using Word 365 and have access to the 
cloud for file storage. 

File tab 
Word has a File tab which is positioned on the left of the Ribbon. Clicking on the File tab 
opens Backstage view. Backstage view is designed to help you manage files and open, 
close, save and print documents. 

 

Ribbon 
The Ribbon provides access to all the tools required for working with a document. 

 

Ribbon tabs 
The Ribbon has a series of tabs along the top. The tabs shown will vary depending on the 
version of Word you are using and how it has been configured. 

Click on the tab to display the Ribbon required. 

 

Context sensitive tabs display when the tools are needed, e.g. the Table tabs appears when 
you are working on a table and disappear when you have finished. 

 

 
 

Word 365 Word Professional 

Groups 
Ribbons are split into groups, e.g. Font Group. Each Group contains command buttons 
appropriate to a particular action. The font formatting tools are in the Font Group. 

 

  

Clipboard 
Group 

Font 
Group

Paragraph 
Group 
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Inserting pictures 
Pictures are inserted using the Illustrations Group on the Insert Ribbon. 

 
Exercise 29 

1. Using Exercise 25… click anywhere in the document and display the Insert Ribbon. 

2. Click on the Pictures button . From the drop-down list that displays select This 

Device .The Insert Picture dialog box will display. 
3. Navigate to the 978-1-921971-70-9 BSBTEC201 exercise files folder. 

4. Double click on the file Cafe. 

When the picture is selected, the Picture Format Ribbon will automatically be displayed. This 
is an extra Ribbon which is used to format pictures and images. 

5. Click on the Wrap Text button  and select Square . This will 
wrap text around the graphic – it can then be moved freely around the document. 

6. Click on the image and holding down the mouse button, drag the image to the right of the 
text under the Casual, Elegant Dining heading. 

When an image is selected handles are displayed around the picture as shown below. 

 

7. Check the image is selected with handles displayed on each corner. 

8. Position the mouse pointer over the bottom right handle. The mouse will display as . 

9. Hold down the Shift key, click on the handle and drag inwards to reduce the size of the 
image slightly (holding down the Shift key resizes the picture proportionally). 

10. Check that the image is now an appropriate size for the document as shown on page 61. 
Reposition the image as required. 

11. Insert the image Utensils from the 978-1-921971-70-9 BSBTEC201 exercise files folder. 

12. Change the text wrapping to Square. 

13. Reduce the size of the image and position it to the right of the Elegant, Relaxed Dining 
section. 

14. Save and close the document.  

Handles 
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AutoSum 
The AutoSum button  is used to add values of multiple cells in a worksheet. It is 
located in the Editing Group on the Home Ribbon. The drop-down list button next to the 
AutoSum button is used to select other functions, e.g. average, maximum.  

 

Before clicking on this button, check the active cell is where the result is to appear. 

The AutoSum function will look up the column from the cursor position to find cells to add.  

 

If cells above a total cell do not contain values, the AutoSum function will look to the left of 
the cursor position and select cells to add (across a row). 

 

Exercise 40 

1. Open the file Phone City from the 978-1-921971-70-9 BSBTEC201 exercise files folder. 
Enable editing if required. 

2. Save As the file in your working folder following workbook procedures. 

3. Click on cell E6. 

4. With the Home Ribbon displayed click on the AutoSum button  located in the 
Editing Group. 

 

 The formula displays = (equal to) indicating the start of a formula.  

 The SUM function adds the data in the cells indicated in the range.  

 Brackets are used to display the range to be totalled (from cells B6 to cell D6). 

  

Alt =
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Formatting a worksheet 

Formatting using the Ribbon 
The Font Group and the Alignment Group located on the Home Ribbon contain a variety of 
tools to format a worksheet. 

 

Exercise 61 

1. Using Exercise 42... select cells B4 to E4.  

2. Click on the Bold button  in the Font Group. Keep the cells selected. 

3. Click on the Align Text Right button  in the Alignment Group to right align the column 
headers.  

4. Press Ctrl Home and click  to bold the text Ernie's Stationery. 

5. Click on cell A9 and press Ctrl B to apply bold formatting. 

 Leave the workbook open for the next exercise. 

Formatting using the Mini toolbar 
A floating mini toolbar provides access to some of the tools commonly used to format a 
worksheet. It is activated using the right mouse button.  

 

 

 

To display the mini toolbar select the cell(s) to be formatted and click the right mouse button. 
The mini toolbar and the shortcut menu will display. 

 

Ctrl B

Shortcut menu

Mini toolbar 

Font

Font Size 

Bold

Italic
Borders
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Presentations  
An electronic presentation is a collection of slides used to communicate information in a 
visual manner. Presentations can accompany speeches and lectures or run independently.  

Microsoft PowerPoint 
Microsoft PowerPoint is a presentations app in the Office suite. 

Exercise 80 

1. Click on the Start button .  

2. Scroll down the list of installed apps. 

3. Click on PowerPoint  to open PowerPoint. 

Startup screen 
When PowerPoint is opened the startup screen displays. This screen lists recently accessed 
documents along with a range of templates for creating presentations.  

 

Exercise 81 

1. With the PowerPoint startup screen displayed click on Blank Presentation. 

 

A new presentation based on the Blank Presentation template will be created. 

2. Leave the blank presentation open for the next exercise. 
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Applying themes 

If you have already created a presentation and would like to make it interesting and 
consistent you can apply a theme. Themes are sets of colours, fonts, effects and 
backgrounds that are automatically applied to the objects and elements of a presentation. 

Exercise 86 

1. Using Exercise 85… display the first slide. 

2. Display the Design Ribbon.  

3. Click on the More button  of the Themes Group to display available themes. 

 

4. Move your mouse pointer over some of the themes to preview them in the presentation. 

5. Click on the theme called Basis. (Position your mouse pointer over the theme icon to 
display the name.) The design will be applied to the entire presentation. 

Colour schemes can be changed using the Variants Group. 

 

6. Select the blue variant to apply it to the presentation. 

7. Click on  and press the Spacebar to view the presentation in Slide Show View.  

8. When all four slides have been viewed, press the Esc key. 

9. Save and close the presentation. 

10. Click on the Exit button  to Exit PowerPoint.  
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Viewing a form 
Forms are designed to allow a user to easily enter data into a database. They also allow data 
to be viewed quickly and easily on screen. 

Exercise 93 

1. Using Exercise 89… from the Navigation Pane double click on frmDiverDetails 

 from the Forms section.  

 

The first record is displayed when the form is opened.  

To browse through the records use the Record bar at the bottom left of the form.  

2. Click on the Next record button  to move to the next record. 

3. Click on the Previous record button  to move to the previous record. 

4. Leave the form open for the next exercise. 

  

Record bar
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Quick Access Toolbar 
The Quick Access Toolbar located in the top left corner of the window contains a command 

to send and receive all emails . Frequently used commands can be added to this 
toolbar. 

File tab 
Clicking on the File tab opens Backstage view. Backstage view provides options to set up 
and manage your email account and print emails. 

Ribbon 
The Ribbon provides access to Outlook tools. 

 

Ribbon tabs 
The Ribbon has a series of tabs along the top. Click on the tab to display the Ribbon 
required.  

 

Groups 
Ribbons are split into groups, e.g. Respond Group. Each Group contains command buttons 
appropriate to a particular action. The New Email button is located in the New Group. 

 

 

 

Email list 
The email list shows all the emails in the folder selected in the Folder Pane, e.g. all emails in 
the Inbox. 

Reading Pane 
The Reading Pane displays the contents of a selected email.  

Zoom 
Use Zoom to enlarge or reduce the size of text in the Reading Pane.  

  

New Group Delete Group Respond Group 
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Folder Pane 
The Folder Pane displays all the folders into which mail can be filed. The folders displayed in 
the Folder Pane will vary depending on the type of email account you have and how it has 
been set up.  

 

If a folder has a white triangle beside it , it means there are subfolders within it. Click 
on the triangle to display the subfolders.  

Creating an email  
Exercise instructions 

Exercise 101 to Exercise 104 should be completed in one session without the email being 
closed. 

Exercise 101 

 Check the Home Ribbon is displayed. If it is not, click on the Home tab . 

 Click on the New Email button  from the New Group. A new email will open.  

Note the email has its own Ribbon with different tabs. 

If there are multiple accounts in Outlook, the new email will display a From button 

. Use this button to select the account to send from.  

 Check the preferred address is selected in the From field. 

 Type your email address in the To… box. (You will be sending emails to yourself.) 

 Press Tab twice until the cursor is in the Subject box.  

OR 

Click in the Subject box. 

 Type: Sending email  

 Press Tab. 

OR 

Click in the email message area. 

 Type the text exactly as shown below including the spelling error. 

The internet is great for transmiting emails to people across the world. I am 
presently sending an email.  

Ctrl N
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Signatures 
A signature is text and/or images which can be automatically appended to every email you 
send. A signature usually includes your name, job title and the organisation contact details 
following organisational policies and procedures. 

Exercise 111 

 Click on the File tab  and select Options  on the left of the screen.  

 Select Mail on the left.  

 Locate Create or modify signatures for messages. 

 

 Click on the Signatures button . The Signatures and Stationery dialog box 
will display. 

 If there is more than one account attached to Outlook, select the correct account from the 
E-mail account: drop-down list in the Choose default signature section on the right. 

 

 Click on the New button .  

 Type: Regards into the box to identify your signature. 

 

 Click on OK. 

 Click in the Edit signature box and type: Regards 

 Press Enter then sign off the email following workbook procedures.. 

 

 From the Choose default signature section select Regards from the New messages: 
drop-down list and the Replies/forwards: drop-down list. 

 

This will automatically add this signature to any new emails, replies and forwarded 
emails.  

 Click on OK. 

 Click on OK to close the Outlook Options dialog box. 
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Portable document format (PDF) is multi-platform, meaning that documents saved in this 
format can be opened in a variety of apps. The document will look the same regardless of 
the device used to open it. This standardisation makes PDF a popular format for creating 
documents to be shared by email or downloaded from a website. 

PDF readers 
A PDF reader is required to open a PDF document. Most internet browsers contain a built-in 
reader. Specialised PDF reader apps are also available, the most commonly used Adobe 
Acrobat Reader can be downloaded from the internet for free. 

Creating a PDF from Word 
Creating a PDF of a Word document provides a visually accurate and a more secure 
document for distribution. 

Exercise 137 

1. Open Word.  

2. Open the file Northland from the 978-1-921971-70-9 BSBTEC201 exercise files folder. 

3. Click on the File tab  then click on Export . 

4. Check Create PDF/XPS Documents  is selected and click 

on the Create PDF/XPS button . The Publish as PDF or XPS dialog box will 
display. 

5. Navigate to your working folder if it is not currently selected.  

6. Check PDF is selected from the Save as type: drop-down list. 

7. Remove the tick from the Open file after publishing check box. 

 

8. Click on Publish . The document will be published as a PDF. 

9. Use File Explorer to navigate to your working folder. 

10. Double click on the PDF file Northland to open it. 

11. View the PDF file and then close. 

12. Close the Word document and exit Word. 

Creating a PDF from Excel 
A worksheet, chart or workbook can be exported as a PDF. 

Exercise 138 

1. Open Excel. 

2. Click on the File tab  and select Open . 

3. Click on Browse . The Open dialog box will display. 

4. Navigate to the 978-1-921971-70-9 BSBTEC201 exercise files folder. 

Ctrl O 



© Millbank Investments Ltd, 2021  157 

Evidence guide 

Elements and Performance Criteria 
Element 
Elements 
describe the 
essential 
outcomes. 

Performance Criteria 
Performance criteria describe the performance needed 
to demonstrate achievement of the element. 

Assessment tasks

1. Select and 
prepare to 
use 
technology 

1.1 Identify task purpose, audience, format and 
presentation requirements, and clarify with relevant 
personnel where required

Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7

1.2 Select relevant technology and software applications 
to achieve requirements of the task 

Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7

1.3 Adjust workspace, furniture and equipment to suit 
own ergonomic requirements

Task 1 

2. Input and 
process data 

2.1 Identify and open application, according to task and 
organisational requirements  

Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7

2.2 Enter information or data into application according 
to organisational requirements 

Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7

2.3 Ensure information or data is checked and amended 
according to organisational and task requirements 

Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7

2.4 Format information or data using appropriate 
application functions according to organisational and 
task requirements

Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7

2.5 Use relevant help functions to overcome simple 
issues  

Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7

3. Finalise 
and store 
data 

3.1 Review and edit final information or data, and 
prepare for storage in accordance with organisational 
and task requirements

Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7

3.2 Name and store document and exit application  Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7
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Assessment Requirements 

Performance Evidence 
The candidate must demonstrate the ability to complete the tasks outlined in the elements, 
performance criteria and foundation skills of this unit, including evidence of the ability to: 

 select and use at least three business software applications on two occasions each. 

In the course of the above, the candidate must: Assessment 
tasks 

 select and use technology safely and according to organisational 
requirements 

Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7 

 identify and address faults according to requirements. Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7 

Knowledge Evidence 

The candidate must be able to demonstrate knowledge to complete the 
tasks outlined in the elements, performance criteria and foundation 
skills of this unit, including knowledge of:

Assessment 
tasks 

 key features of:   

 organisation’s work health and safety requirements relevant to 
own role 

Task 1 

 organisation’s requirements for file naming and storage  Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7 

 applications used for organising electronic information and data. Task 2, Task 3, 
Task 4, Task 5, 
Task 6, Task 7 


